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This hand-out is intended to help staff manage 
their outlook in-boxes for their University email 
accounts and to provide tips and suggestions on 
email etiquette. 

Emails are University Records
Email messages sent or received using a 
University email account that refer to or contain 
information on or about University business 
whether from within or outside the University 
are owned by the University. This applies to all 
University emails whether or not the equipment, 
software, or facilities used to create or store 
the email record are owned by the University. 
As such all email which you create during your 
employment at UC, unless for specific teaching 
or research purposes, is part of the University’s 
corporate record and may be accessed under the 
Official Information Act or Privacy Act. 

Emails are considered to be records with as 
much importance as formal documents and 
they must be managed according to the General 
Disposal Authority for University records. Further 
information is provided in this document on 
saving emails and more information about the 
General Disposal Authority can be found on the 
Information and Records Management (IRM) 
website or by contacting the IRM team.

Saving Records
With the heavy use of email in business processes 
it is important to ensure that those emails which 
record important decisions are kept as an official 
University record. Sometimes an email is the only 
official record of certain decisions. Be aware of 
this in your own work and save key emails to your 
Department file share or SharePoint site. 

The easiest way to do this is to print the email 
to the Amyuni PDF Convertor print queue. This 
will create a PDF of the email. To do this under 

the printer dropdown menu select ‘Amyuni PDF 
Convertor’. Select Print. In the pop up box select 
your location to save to, and then name the file.

Remember to rename the file to something useful 
along the file naming guidelines, otherwise you 
can end up with many files named un-useful 
titles such as ‘FW:RE:Meeting 13 May’ instead  
of ‘Procurement Paper for Council Meeting  
13 May 2013’.

University records must be saved in line with the 
General Disposal Authority for NZ Universities 
which is mandated under the Public Records Act. 
For more information on this please see the IRM 
Process Manual, the IRM website or contact the 
IRM team (links at the end of this document).

Etiquette
Having good email etiquette and following best 
practice when writing emails helps to ensure that 
you do not create any privacy breaches or other 
problems for yourself or the University in the 
future. Remember that every email you write as a 
University employee is discoverable (can be found 
and retrieved via searching Outlook) and may end 
up being supplied to an external person through 
an Official Information Act request or a personal 
data request. Content of an email can also be 
inadvertently seen by the wrong recipient if it is 
forwarded by accident or emailed to the incorrect 
address. For more information about personal 
information and what should and should not be 
included in an email please see section 6.7 of the 
Privacy Policy.

‘Don’t write anything in  
an email that you wouldn’t 
write on a postcard’
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Do Don’t

Be careful when talking about students/staff/
stakeholders. Always imagine that your email 
can be seen by the person you are talking about, 
and if in doubt pick up the phone instead. 
Remember that even seemingly mild  
comments can turn into the ‘smoking gun’  
in certain situations.

Don’t put anything slanderous/libellous in an 
email. This is stating something false which 
would be damaging to the person’s reputation.

Do be sensible when managing your records. 
Not creating records or deleting them incorrectly 
may breach employment conditions or even  
be illegal.

Don’t send a message when you are angry.  
Save it to your drafts and come back to it later 
with a clear head, or get someone else to read 
through it.

Read your message before you send it. 
Remember that emails don’t carry visual 
clues and language or tone can be easily 
misconstrued.

Don’t use read receipts on every message. Only 
use if you are unsure if your recipients will 
receive the email.

Make the subject line descriptive – if an action is 
required state this.*

Don’t overuse the high importance ‘!’,  
your recipients will learn to ignore them.

Change the subject of the message if the topic 
of the conversation changes.

Don’t use ALL CAPS – it sounds like you  
are shouting.

Keep all messages short, to the point and 
professional.

Don’t send attachments when you could  
send a link – particularly in meeting requests as 
this sends a copy to everyone and adds to the 
server load.

Use bold to draw attention to people’s names or 
actions where required.

Don’t write something you wouldn’t want 
everyone in the University to read – you can 
never be sure of where an email will end up.

Limit the number of people you send a message 
to. Put those who need to respond in the ‘To’  
line and those who are just being informed in 
the ‘Cc’ line.

Don’t use ‘funny’ fonts. They are hard to read 
and look unprofessional.

Acknowledge messages which need a more 
extensive response if you cannot do something 
right away. Manage people’s expectations.

Don’t forward emails before checking the  
full email text – large email streams can  
hold surprises.

Explain to people when you CC them in on  
an email.

Do not use bullying behaviour e.g. don’t Cc  
your superior or someone else’s superior in on 
every email.

*Note that long or non-descriptive titles cause additional problems when emails are added to SharePoint.  
The subject line pulls through as the title of the document



Emailing groups and  
shared mailboxes
For information on emailing to groups of 
students please see the UC Policy ‘Group Emails 
to Enrolled Students’.

If you are sending an internal email to more than 
25 people a mail tip will notify you of this. Mail 
tips are the notifications which appear above the 
‘Send’ box in a drafted email.

If you regularly email a group of people consider 
creating a distribution group. This can help 
ensure that all required people get all the 
appropriate messages and prevent any issues 
around autocompleting of names etc. Contact 
the ICTS helpdesk to see if creating a group is 
appropriate for you, or create your own Contact 
Group with Outlook.

Security
It is important to be careful in your email 
behaviour. Always review the content and 
recipients before you hit send. One wrong 
address and you can easily create a privacy 
breach.

UC has an email disclaimer which is appended 
to all emails when they leave the UC system 
externally. It is important for legal reasons that 
this is maintained and is not altered for your own 
purposes. Do not append additional disclaimers 
to email signatures. Further information on this 
can be found in the Privacy Policy.

If you are concerned about security issues, or you 
work in a ‘high-risk’ area (we would define high-
risk as an area where you regularly email external 
contacts or groups of people) there are things you 
can easily do to mitigate your risk.  

For example you can turn on mail tips which 
notify you about various features. Here are some 
measures you can take:

•	 Turn on the mail tip which notifies you when 
your email message is going to external 
recipients. To do this: In Outlook select the 
‘File’ tab, select ‘Options’, select ‘Mail’, under 
‘MailTips’ select the ‘MailTips Options’ button. 
There are various functions which can be used. 
In this case tick ‘External recipient’, click ‘OK’

•	 Turn off Auto-Complete for email addresses. 
This is the feature which displays email 
suggestions as you type. It is very easy to 
select the wrong one. To turn this off: In 
Outlook select the ‘File’ tab, select ‘Options’, 
select ‘Mail’, under ‘Send messages’ un-tick the 
check box ‘Use Auto-Complete List to suggest 
names when typing in the To, Cc and Bcc lines’, 
click ‘OK’

•	 Turn on the Spellcheck function. This requires 
you to take a minute and revise and often gives 



you a second chance to notice any problems. 
To turn this on: In Outlook select the ‘File’ tab, 
select ‘Options’, select ‘Mail’, under ‘Compose 
messages’ tick the check box ‘Always check 
spelling before sending’, click ‘OK’.

•	 Defer the sending time of your emails. This 
function allows you to put a time of a minute 
or more, on the sending of emails. This can 
help stop those “oh no” moments. To do this 
follow the below steps from your Outlook: 

1. Select the ‘File’ tab

2. Select ‘Manage Rules & Alerts’

3. In the dialog box which pops up select ‘New 
Rule’. This will cause another pop up to appear 
called the ‘Rules Wizard’

4. Under ‘Start from a blank Rule’, select ‘Apply 
rule on messages I send’, then click the  
‘Next’ button

5. Click ‘Next’ again, which will apply this rule  
to every message you send (or select criteria  
to limit the application)

6. Select the check box ‘Defer delivery by a 
number of minutes’

7. In Step 2, click on ‘A number of’, then select  
the number of minutes to defer by and  
select ‘OK’

8. Select ‘Next’

9. Name the rule ‘Defer on sent items’ and  
select ‘Finish’.

Organising your Inbox
Organising your inbox in outlook can make your 
working day more efficient and effective. Below 
are some ideas for ways to help you do this. 
Please remember that Outlook is not a secure 
repository for record keeping and important 
email records should be saved to a file share or 
SharePoint as appropriate.

•	 Create sensible folders for the way you work 
e.g. create folders for specific areas of your 
work or for projects. Don’t put folders under 
your inbox, put them at the same level. This 
keeps your email totals down and prevents 
your system from slowing

•	 Always create a folder called ‘1-Reference’ and 
‘2-Personal’. These two folders will appear at 
the top of your folder list and allow you to 
easily drag and drop items out of your inbox 

•	 Set your categories to colour code your inbox 
and help prioritise your work. You can use a 
combination of topics, activities, locations or 
priorities e.g. Planning, Reading or Meeting

•	 Use rules to send emails from listservs, contact 
groups and distribution lists into folders for 
later reading

•	 Apply rules to divert emails. For example if 
you do a lot of meeting organisation, create a 
rule which puts automatic meeting responses 
without content into a separate folder, or, 
directly into deleted items

•	 Set emails sent only to you, to show in a 
different colour. To do: Go to the ‘View’ tab on 
the Outlook toolbar, select ‘View Settings’. In 
the pop up box select ‘Conditional Formatting’, 
click ‘Add’, type ‘Me’, click ‘Font’, under ‘Colour’ 
select a different colour and click OK. Click 
‘Condition’, next to the ‘Where I am’ tick box 
select ‘the only person on the To line’,  
select ‘OK’

•	 Notifications – if you are easily distracted or 
you receive a large amount of emails it can be a 
good idea to change your notification settings. 
You can turn off various alerts such as the 
notification sound and the desktop alert. To do: 
In Outlook select the ‘File’ tab, select ‘Options’, 
this will open a new pop up box. Select ‘Mail’. 
The options are available under  
‘Message arrival’



•	 Flag on send. When you send a message to 
which you require a response, you can select 
the ‘Follow Up’ flag prior to sending the email. 
You can change the timeframe on this from 
a day to next week etc. This is incredibly 
useful and puts a task into your tasks bar as a 
reminder. This can then be renamed for clarity 
if needed. Similarly, when you promise to do 
something in a message, you can flag it for 
yourself as a reminder

•	 Use the Conversations view. This is useful 
to see the whole email discussion in one 
stream. It has the advantage of showing 
the whole discussion even if specific emails 
are in separate folders. To do: Select ‘View’ 
on the Outlook toolbar, tick the ‘Show as 
Conversations’ box

•	 Use the ‘Clean Up’ function. This button is 
available on the main Outlook toolbar. You 
can use it to clean up specific conversations, 
folders or subfolders. It works by eliminating 
messages which are completely contained in 
later emails from the same conversation (note 
that if the subject line has changed during 
the conversation it will not consider these as 
part of the same email chain). Deletion in this 
context is approved under GDA 1.2.2.

Case Studies

Case Study 1:  
Information breach –  
email sent to an incorrect recipient

As part of Sandra’s job 
she regularly sends out 
emails to groups of 
staff/stakeholders in a 
Committee. Each email 
contains the upcoming 
papers for the Committee 
meeting. 

On Friday, Sandra is in a 
rush to complete her work 

and leave for the weekend. She quickly types in 
the email addresses and hits send. She neglects 
to double check the email addresses before 
sending the email. 

On Monday morning Sandra comes in to work 
and finds that when she sent the email she had 
utilised the auto-complete address function 
and had sent the email to two incorrect people. 
These people have now received confidential 
information about the University in the attached 
documents. One of them is threatening to go 
to the media with the confidential information 
which they now have.

Issue: An information breach has been created 
and confidential documents or information may 
turn up in the media. 

Risks: Reputational, Financial, Commercial

Solution: Ask ICTS to create an email group for 
regularly emailed cohorts or create your own 
Contact Group in Outlook. Additionally in emails 
of this sort, where able, send links to documents 
rather than attachments. Recipients then have 
to have the appropriate security permissions to 
access the documents.

For further tips and helpful ideas see the 
Microsoft Best Practices for Outlook 2010 
document available in the help section of 
Outlook or directly here:  
http://office.microsoft.com/en-nz/outlook-
help/best-practices-for-outlook-2010-
HA102459562.aspx

For more information please see the IRM 
website or contact the IRM team: 

http://www.canterbury.ac.nz/irm/ 
records@canterbury.ac.nz



Case Study 2:  
An Official Information Act (OIA) 
request reveals inappropriate email 
correspondence

Stewart deals directly with 
students some of whom 
have very problematic 
issues. In general, he 
manages to not get 
too worked up about 
anything, but one student 
who has had many 
complaints has managed 
to really irritate him. 

This student comes in with another complaint 
and Stewart sends an email to a colleague letting 
them know that this student will be heading 
their way to further their complaint. In the email 
Stewart says ‘That annoying prat (you know the 
one) is on his way over to see you. Expect him 
shortly.’ This email becomes part of a stream of 
correspondence about the student which has the 
student’s name mentioned in it.

One year later… 

The University receives an Official Information 
Act request from the student requesting all 
correspondence relating to them. Relevant staff 
search their email correspondence and retrieve 
all relevant documents. The email which Stewart 
sent is included within this. Once the requestor 
sees the stream involving Stewart’s email he 
decides that the University has been working 
against him and resolves to take his case further.

Issue: A seemingly casual remark can have major 
consequences.

Risks: Reputational, Financial, Legal

Solution: Never put anything slanderous or 
derogatory in an email, and always maintain a 
professional tone

Case Study 3:  
Lost decisions in an email,  
lead to loss of revenue
A senior staff member made an agreement with 
a tenant that they would pay only a nominal 
rental fee for ten years on a property owned by 
the University. This agreement was not recorded 
formally on the contract or accompanying 
documents, only via email.

This staff member then left employment at the 
University without saving the content of this 
email anywhere.

3 years later…

The University realises it has not been getting the 
rent it expects from a tenanted property. They 
search the documentation around this to see if 
there is any reason for the discrepancy. Finding 
no documentation they start proceedings against 
the tenant for the lack of payment.

Matters escalate rapidly and the University ends 
up in the Courts and the media for the case. The 
tenant produces the email which shows that the 
University agreed to the arrangement. 

Issue: A lack of documentation leads to exposure 
in the eyes of the law and the media.

Risks: Financial, Reputational

Solution: Always save important decision 
documents, even those in email format.
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